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Navigat ion & Preferences
 

Navigating from one feature to another is very simple in Tempo. 

 
 

The Main Menu contains the names and icons associated with the functions that are available 

in the Tempo MLS system. The functions that are currently available are: 

  

 My Tools: This icon provides access to the My Page and Add/Edit functions along with 

miscellaneous permission-based functions and reports. 

 Add/Edit: This icon provides access to the Add/Edit listing, media and open house 

functions. 

 Search: Click the Search icon to perform and create searches. 

 Reports: This icon allows you access to Statistics, Hot Sheets, Agent Reports, Open 

House and CMA History reports. 

 Prospects: Click Prospects to create or view prospecting information. 

 Tax: Click Tax to search and view tax information. 

 Financial: Financial allows you to create financial worksheets. 

 Member Info: This icon allows you to access the MLS member roster and other MLS 

information. 

 Home Icon: Returns the user back to the Tempo home page. 

 Envelope Icon: Allows the user to email technical support. 

 Question Mark Icon: Access to the on-line help manual. 

 Light Switch Icon: The log-off button. 

 

To adjust/setup your system preferences, hover on My Tools, then click My Page. 

 

 

From My Page, you can reset your password at 

any time, assign a Supra to your listing(s), view 

CMA’s that Ǉou haǀe Đƌeated ǀia the CMA Wizaƌd 
and view information on violations assessed to 

you or reported by you. 

 

Click on Preferences to add your personal photo 

if you choose.  The photo appears on the Client 

Gateway websites as well as the cover of a CMA. 

 

Then, select Email Preferences from the left to 

configure your signature, which will be used 

when emailing properties from within Tempo. 



Page χ Teŵpo™ BasiĐ Couƌse HaŶdout – Revised Feb 2015 

MMM 
 

Sidebar
 

The Sidebar is available from anywhere within Tempo and contains helpful content to make 

your job easier.  It is collapsible to preserve space.  To open the Sidebar, click My Sidebar on 

the left side of the screen and it will slide open.  To minimize it, simply click My Sidebar again. 

 
 

 

MLS Links are links to useful resources provided by the 

MLS.  The user cannot configure this area of the Sidebar. 

  

My Links are links that the user can place in the Sidebar as 

their own favorites.  To configure My Links, use 

the Preferences option. 

  

Prospect Watch allows the user to view prospect listing 

matches from searches and prospects they have already 

configured within Tempo. The listing matches can be 

viewed as either a Prospect Web Site or a Report. 

 

Inventory Watch allows the user to view their inventory. 

The type of inventory viewed can be configured with 

the Preferences option. 
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Performing a  Quick  Search
 

Quick Search allows users to search for listings that match specific criteria, (i.e. location, price, 

number of bedrooms).  The resulting information can be viewed in various types of reports. 

 
To run a Quick Search, 

Step 1:          Hover your cursor over the Search icon. 

Step 2:          Click Quick Search in the drop-down menu.  The Quick Search screen will appear. 

Step 3:          Click a property type tab at the top of the screen.  Note that you can use the All tab 

to search across all property types. 

Step 4:          Fill in the fields that are applicable to the search and leave the remaining fields 

blank.  If the field is a text box, type your entries and separate each with a comma.  To select 

multiple items in a list box (such as Status), click the first item, then press and hold the CTRL key 

while clicking each additional item. 

 

Area 
To narrow your quick search to a specific area or areas, type the number or numbers in the 

Area text box.  If Ǉou doŶ’t kŶoǁ the Ŷuŵďeƌ foƌ the aƌea;sͿ, ĐliĐk the Select Area link, which 

will open a window that lists both the name and number of each area.  You can then select one 

or more areas from this list.  Note: Area is not a required field. 
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Property Information 
The Property Information section down the right hand side of the 

Quick Search screen contains various criteria that can be searched 

(e.g., List Price, Beds, Full Baths, etc.).   You may search by any or 

all of these fields.  

 

Status 
You can narrow your Quick Search according to the status of the 

property.  (Status refers to a listing as being Active, Option 

Pending, Sold, etc.)  To narrow the search criteria even more, you 

can enter other information such as a Sold Price, Closed Date, and 

Pending Date. 

 

Range Fields 
You can use range fields to narrow your Quick Search results.  

 The boxes in the left-hand column of the Property 

Information section are for minimum values.  This column 

is labeled Begin Range. 

 The boxes in the right-hand column of the Property 

Information section are for maximum values.  This column 

is labeled End Range. 

 Place the mouse pointer in the appropriate box, click once 

and then type in a number.  Numbers can be entered in 

either the Begin Range or End Range column, both 

columns, or left blank.  

 The more criteria you enter, the more focused the search 

results will be……the feǁeƌ ƌesults Ǉou ǁill get.

 

Wild Cards 
Many common names/words may be spelled differently, making them difficult to find in a 

search.  For example, Oakwood may be spelled Oak Wood, Oakwoode, or Oakwoods.  To make 

sure the user does not miss a listing, Tempo uses wild cards.  The wildcard, a % sign, is 

autoŵatiĐallǇ added to the eŶd of ŵost teǆt, although it isŶ’t displaǇed.  For example, if a user 

types Oak, the system will find Oakwood, Oak Wood, Oakwoode, and Oak Woods, as well as 

Oakdale and Oak Hills.  On the other hand, if the user is not sure if they are looking for Perry 

Street or Ferry Street, they must type in the % sign at the beginning of the word.  Type %erry 

and the system will find Perry, Ferry, Berry, Kerry, and Jerry Streets. 

  

Tempo also alloǁs a useƌ to plaĐe aŶ ͞=͟ sigŶ afteƌ a text field, thereby limiting the search to 

the exact word typed in without utilizing the wild card.  Foƌ eǆaŵple, tǇpiŶg ͞Meŵoƌial=͟ ǁould 
fiŶd just the suďdiǀisioŶ ͞ŵeŵoƌial͟ ǁithout displaǇiŶg Meŵoƌial PiŶes, Meŵoƌial TƌaĐe, etĐ. 
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Negative Search 
Tempo can perform a negative search to exclude certain listings.  For example, if a client does not want 

to look at properties in zip code 77532, he or she could enter -77532 in the Zip Code field.  Multiple 

items may be excluded by typing them into the box with a minus (-) sign in front of each, separated by 

commas.  

 

Entering Dates, Numbers, and Dollar Amounts 
 When entering a date, separate the month, day, and year with the slash (/) that is located 

beneath the question mark (?) on the keyboard.  

 Do not put spaces or commas in numbers.  

 Remember to use the number zero (0) and not the letter O.  

 When entering dollar amounts, enter all zeros but no dollar signs, decimals points, or commas. 

 

Search Now 
The Search Now button on the Quick Search screen will display up to 250 listings in a line item 

report.  Tempo will sort the results by status first, then by list price (lowest to highest). 

Search Results Page 

 

Viewing Listings from Quick Search 
To view the results of a Quick Search, click the Search Now button.  

 

Quick Search results are listed in a one-line format.  Click on the colored, underlined MLS number to 

view the Agent Property Report for that listing.  All listings can then be viewed by using the toolbar at 

the top of that screen.   
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The toolbar contains common activities for the page: To List, Prev (previous), Next, and Select. 

 The Next and Prev buttons allow quick navigation through the list of search results 

without going back to the search results page. 

 Click the Select checkbox to mark the listing as being of interest.  This has the same 

effect as checking the select box next to the MLS number on the search results page. 

 The To List button will return you to the previous screen and displays the search results 

again. 

 To print a report, click the To List button to go back to the line item results page and a 

check will appear in the box to indicate that the listing is selected.  

 The Check/Uncheck button on the left side of the Available Reports box will select or 

deselect all of the listings. 

 To display multiple reports on a single screen, select the listings, then click a report 

name in the Report Functions box.  (Report Functions is at the bottom of the search 

results screen.)  A separate window will open and display the listings in a single, 

scrollable screen.  To print these reports, right click on the report page and 

select Print in the pop up box.  
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Statistics 
Valuable statistical information is available from the Quick Search screen as well as the Results 

Grid.  Once you have entered your search criteria/obtained your results, click the Statistics button to 

view statistical data for the matching listings.       

 
(Quick Search view) 

 

 
(Results Grid View)

 

 
The results show the total number of listings found for each status and the minimum, average, and 

maximum values for certain fields that have been selected by HAR.  

 Click View Requested Listings to view a list of up to 250 listings. 

 Click Revise and search again to either narrow or expand your search. 

 

Downloading 
The Download function may be found in various areas of the system, such as Quick Search, Custom 

Search and Custom Reports. 

The total number of properties that can be downloaded per download session is 1500.  A user may 

download all available fields in a text file, capable of being imported into numerous software programs 

(e.g., Microsoft Word
®
, Excel

®
, etc.).  Once you download the file, remember where you save it so you 

can retrieve it later.  
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Other  Search  Methods
 

The MLS Number Search allows the user to view specific MLS numbers in various ways.  

  

To conduct an MLS number search, pause your cursor over the Search icon, then click MLS # 

Search in the dropdown list.  The MLS number search screen will appear. 

 
 

Executing an MLS # Search 
Step 1:            Enter a valid MLS number.  Users may enter more than one MLS number 

(Maximum 99) at a time, separating them with commas. 

Step 2:            Select a report format from the Available Reports box or click E-mail 

Listings, Download or Map. 

 

 

Archive Search 
To view the history of a property, select Archive Search from the Search option on the 

Navigation bar. 

 

 

You ĐaŶ ƌeseaƌĐh a pƌopeƌtǇ’s histoƌǇ ďǇ 
searching by MLS number or by street number 

and address.  If you search MLS number, you 

will receive only the history of that specific 

MLS number.  However, if you search street 

number and address, you will get a complete 

history for that property over the past 5 

years.  You may also conduct a Tax ID search 

from the Archive Search screen. After you 

enter the information, click Search Now for 

results. 
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The Property Archive Report (PAR) shows the full, true history of a property in MLS including 

price changes, status changes and agent changes.  The Days on Market (DOM) indicates how 

long a property has had its current MLS number.  Cumulative Days on Market (CDOM) indicates 

the total number of days the property has been available in MLS.  If a property has not sold, but 

has gone off the market and come back on the market (T or X) and the gap between those 

dates is not 6 months or longer, all the days it was available in MLS are counted in the CDOM.  

Any time a property is in the Withdrawn status, it pauses the counter until the listing is 

returned to an available status (A, OP or PS).  
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Avai lable  Reports
 

A list of available, printable report formats is located on all search results screens.  Use the 

scroll bar at the right of the Available Reports box to access the formats not visible on the 

screen.  

 To view listing(s) in a particular format, click the desired report name.  (The names of 

the available reports will be displayed in a scroll box toward the center or bottom of the 

search results screen.) 

 To print a report, click the report name as described above.  When the report opens, 

right click in the report window and select Print in the pop up box. 

 

The Available Report Formats are: 

Agent Full Report - This report is a complete detail with a photo. It may contain agent-centric 

or confidential information and should not be given the clients. 

 

Agent Short Report - This report is a shorter version of the above. 

 

Buyer Full Report - This is a complete detail page with a photo.  This report does not include 

Agent Remarks or confidential information and may be given to clients. 

 

Buyer Full Photo Report -This report is the buyer full report that includes all photos associated 

with the listing on a separate page following the report 

 

Buyer Short Report - This is a shorter version of the above. 

 

Buyer Half Report - This report displays two properties per page. 

 

CMA Report - This report compares properties selected according to certain criteria. 

 

CMA Buyer Report - This report compares properties selected according to certain criteria. 

 

Line Item Report - gives the same information that is seen on the Search Results Page, but 

allows printing without all of the navigation buttons. 

 

No Photo Full Report - This is the same as the Agent Full Report without a picture.  

 

No Photo Short Report - This report is a shorter version of the No Photo Report. 

 

Archive Report - gives a complete history of a property in MLS, including fields that were 

changed, what information was changed and who made the change. 
 

Full reports display one listing per page; Short reports display three listings per page. Half 

reports are two listings per page. 
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Links in Reports 
Text that is colored and underlined in reports are links to additional information.  Click on these 

links for more details.  For example, if you click on an underlined address in a report, Tempo will 

display that address on a map.  

 

Link to Agent Information 
WheŶeǀeƌ Ǉou see aŶ ageŶt’s liŶk iŶ a listiŶg ƌepoƌt, Ǉou ĐaŶ ĐliĐk it to pull up that iŶdiǀidual’s 
information.  The information may include a cell phone number, a web page or e-mail address, 

etc.  To print the information, right click anywhere on the agent information screen, then select 

Print in the pop up box. 

 

Pictures 
When viewing a listing, click the picture to open a separate media page.  If a listing has only one 

picture, clicking that picture will open it at a higher resolution.  However, if the listing has more 

than one picture, all pictures will be displayed and you can click each one to see the larger 

picture.   

  

To return to the listing, click the Back to Details button.  There may also be links to additional 

media, virtual tours, or websites. 

 

Email Listing(s) 
You can manually email listings directly to a client from any search result using these steps: 

Step 1:          Select the listings in the search results.  

Step 2:          Click the Email Listing(s) button at the bottom of the screen.  You do not have to 

select a report format at this point since this option appears on the email form.  

Step 3:          Complete the email form.  

Step 4:          Select the report(s) to send, then click the Send Email button. 

 

Email Opt-Out 
ClieŶts Ŷoǁ haǀe aŶ ͞opt-out͟ optioŶ iŶĐluded iŶ eŵails that theǇ ƌeĐeiǀe fƌoŵ ageŶts.  To opt 

out, clients may click the blue underlined opt out link at the bottom of the email.  If they click 

this link, they will see the following screen:   

 

When the client fills out this form and clicks the ͞I wish to Opt Out” button, Tempo will send a 

confirmation email to that client.  The client will not be opted out until he or she clicks the link 

in the confirmation email. 

 

An email is also sent to the agent when a client confirms that he or she wishes to opt out.  From 

that poiŶt foƌǁaƌd, the ageŶt ǁill see a ƌed sǇŵďol oǀeƌ that ĐlieŶt’s eŶǀelope iĐoŶ iŶ the View 

Prospect list.  

 

  



Page υχ Teŵpo™ BasiĐ Couƌse HaŶdout – Revised Feb 2015 

MMM 
 

Additional Report Buttons 
 

Uncheck All Listings  - Deselect listings that have been previously been selected 

 

Narrow Listings -Remove unchecked listings from search result page. 

 

Email Listing(s) – Manually email preselected listings to client 

 

CMA Wizard - Create a CMA with pre-selected listings from search result page.  

 

Map -Map selected listings in separate window plotting each property. 

 

Revise Search -Return to previous search criteria. 

 

Custom Reports  - Allows users to sort results with specific fields. Displays 1-liner report with 

field defined by the user. 

 

Save As Custom - Save search criteria from a Quick Search into a custom search; .link the saved 

search to prospect. 

 

Printer Friendly  - List search result in separate window without MLS# links to reports. (This 

report does not have the email feature). 

 

Download  - Download MLS numbers into text format for uploading into other software 

programs. 

 

Statistics -Create statistical report with minimum, average, maximum, and median results. 
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F inanc ia l  Worksheets  
 

The Financial section lists a variety of financial reports and calculators. 

 

Seller’s Net Sheet 
The Seller’s Net Sheet ĐalĐulates estiŵated Ŷet pƌoĐeeds ďǇ suďtƌaĐtiŶg the selleƌ’s eƋuitǇ fƌoŵ 
the closing costs.  To geŶeƌate a “elleƌ’s Net “heet, go to Financial > Seller’s Net Sheet. 

  

Do not use commas or dollar signs when entering dollar amounts.  Click the Calculate button to 

calculate the Sellers Net Sheet for that particular transaction.  CliĐk the ͞ǆ͟ iŶ the top, ƌight-

hand corner to return to the previous page. 

  

Click the Reset button to reset the form to its default entries.  CliĐk the ͞ǆ͟ iŶ the top, ƌight-

hand corner to return to the previous page. 

 

Buyer’s Worksheets 
The Buyer’s Worksheet calculates the estimated net funds required to close a property.  To 

geŶeƌate a BuǇeƌ’s Woƌksheets, go to Financial > Buyer’s Worksheets.  

  

Do not use commas or dollar signs when entering dollar amounts.  Click the Calculate button to 

ĐalĐulate the ďuǇeƌ’s ĐlosiŶg Đosts foƌ that paƌtiĐulaƌ tƌaŶsaĐtioŶ.  CliĐk oŶ the ͞ǆ͟ iŶ the top, 
right-hand corner to return to the previous page. 

  

Click the Reset button to reset the form to its default entries.  

 

Amortization Schedule 
The Amortization Schedule summarizes monthly payments based on purchase price, down 

payment, interest rate, and loan period.  To generate an amortization schedule, go to Financial 

> Amortization. 

  

Do not use commas or dollar signs when entering dollar amounts.  Click the Details button to 

create a monthly detail report on payments. This report will show payment, principal, interest, 

and balance per month for the duration of the loan.  CliĐk oŶ the ͞ǆ͟ iŶ the top, ƌight-hand 

corner to return to the previous page. 

 

Rent vs. Buy 
The user can produce a Rent vs. Buy report, which shows the cost advantages of buying over 

renting.  To access this report, go to Financial > Rent vs. Buy.  

  

Do not use commas or dollar signs when entering dollar amounts.   
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Add/Edit  Funct ions  
 

The Add/Edit section is where listings are entered, edited and viewed. If there is no icon for 

Add/Edit, the user does not have permission (access) to this section.  

  

There are three sections within Add/Edit: View Menu, Property List and New Listings.  To view 

these sections, single-click the Add/Edit icon. 

 View Menu - In this section, the user can view specific properties, choosing to view 

either Listings by Agent, or Listings by MLS #. 

 Property List - This page will display the results from the View Menu. 

 New Listing - Users will be able to add new listings or edit existing ones from this page. 

  

View Menu 
To access the View Menu, single-click the Add/Edit icon. 

  

The View by Agent section allows the user to view his or her own listings (or the listings of 

agents he or she has been assigned to see).  To ǀieǁ listiŶgs, seleĐt the ageŶt’s Ŷaŵe, the 
appropriate statuses and property type(s), then click the Show Listings by Agent button.  A line 

item property list will appear that matches the criteria entered. 

  
Note: Brokers have the option to view property information for anyone in their Brokerage.  Office Assistants can 

only view listings for members to whom they have been assigned.  Users will only see their listings if they 

have Add/Edit permissions. 

  

The View by MLS Number(s) section allows the user to find a listing by entering the MLS 

number(s) and clicking on the Show Listings by MLS Number button. The Property List page will 

then display the requested listings. 
  

Note: Listing results from the Show Listings by MLS Number will only appear if the logged-in user has editing 

permissions for the agents who own those listings. 

 

Property List 
To access the Property List screen, click the Add/Edit icon, then click the Property List tab. 

  

This page displays the search results that you specified on the View Menu tab.  In other words, 

if you ran an MLS Number Search or a Show Listings by Agent Search on the View Menu, those 

results would appear on the Property List tab.   

 

Checking the radio button next to a listing selects that listing for further action.  Incomplete 

listings do not have an MLS number assigned to them. However, an MLS number will be 

assigned to the listing as soon as it becomes Active. 

The buttons below the property list allow the user to complete certain tasks.  Each task is 

described below.  
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Edit 
If a listing on the Property List screen needs to be edited, check the radio button next to the 

desired listing, then click the Edit button.  The full listing form will be displayed, allowing the 

user to modify most of the values for the listing. 

 

This screen (as shown above) is the same whether completing a new listing or editing an 

existing one.  All listing edits are made on one page.  Simply use the scroll bar on the right side 

of the browser window to view additional fields.  

  

To change or input information, do one of the following: 

 click in a field and type 

 select a value from a drop down list, or 

 click a radio button.   

  

The fields in blue require information to be entered or selected.  

 To access dropdown menus, click the down arrow next to the field.   

 To move from one field to the next, press the Tab key on the keyboard.   

 An error message may appear while you are entering data.  (This will occur if the type of 

information that you are entering is incorrect for that particular field.)  If so, click OK in 

the warning box that pops up and re-enter the correct type of information.  

 When you have entered all of the information, choose either Save or Cancel.  

 Click Save to saǀe all of Ǉouƌ Ŷeǁ data ǁithout ĐhaŶgiŶg the listiŶg’s status.  For 

example, an active listing will remain active and an incomplete listing will remain 

incomplete.  

 Click Cancel to discard any changes that you made to the listing.  You will then be 

returned to the property list. 

 If the listing is in an incomplete status, selecting Save as Active will update the property 

to active status and assign it an MLS Number.  Note: The Save as Active option appears only 

when entering or editing an incomplete listing. 

 

Change Status/Price/Listing Agent 
This feature allows the user to change the status or price of the listing.  To access this feature, 

select a listing on the Property List screen, then click the Change Status/Price/Listing Agent 

button. 
  

Note: The current status of the listing determines the future status to which the listing can be changed. 
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Add/Edit Media 
The Add/Edit Media feature allows users to add and edit pictures and URLs for their listings.   

  

To access the media feature, select a listing on the Property List screen, then click the Add/Edit 

Media button.  Once the media page has opened, the user has the choice to edit pre-existing 

media or add new pictures or URLs. 

 To edit the media for a listing, select the item to be edited in the Current Media 

List.  Use the Move Up or Move Down buttons to rearrange the display order.   

 Click Edit Selected Media to add or change a caption.  

 Click Delete Selected Media to delete an item 

 Click View Selected Media to display the media 

 Click Set as Primary Photo to make the selected picture the primary photo for the 

listing.  (The primary photo will always be displayed on the Property Full Detail page). 

  

To add media, 

Step 1:            Select a listing on the Property List screen. 

Step 2:            Click the Add/Edit Media button. 

Step 3:            Scroll down to the Add New Media section and select a media type. 

Step 4:            Click the Add New Media button. 

Step 5:             Use the Browse button to locate the picture or file, then double-click the file 

name.  Type in any captions, then click Submit.  The picture will now be associated with the 

listing.  ;Foƌ URL’s, eŶteƌ the addƌess in the box provided.) 

  

You can also order pictures on-line for a fee.  Simply click the Order Pictures button on the 

Property List page and follow the steps. 

 

Fax-in Documents 
This feature enables you to attach media (usually documents) to a listing by fax.  

Step 1:            Select a listing on the Property List Screen. 

Step 2:            Click the Add/Edit Media button. 

Step 3:            Scroll down to the bottom of the page.  

Step 4:            Select Agent Only or Public Display.  

Step 5:            Click the Add New Media button. 

Step 6:            Type a title and description. 

Step 7:            Click the Create Cover Sheet button. 

Step 8:             Print the fax cover sheet that appears and make it the first page of your fax-

in   document.  Fax these pages to the 800 telephone number printed on the fax cover sheet. 

Your document will then be converted to a PDF and will be available through your listing. 
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Edit Open House 
To edit open house information from the Property List screen, complete these steps: 

Step 1:            Select a listing. 

Step 2:            Click the Edit Open House button. 

Step 3:            Add or edit the information as necessary.  

 

Print Preview 
This feature displays a listing from the Property List screen as a No Photo Full Detail report.  To 

preview a listing in this format, complete the following steps: 

Step 1:            Select a listing from the Property List screen. 

  

Step 2:            Click the Print Preview button. 

 

Copy 
There may be times when you will list a property that had already been listed in the past.   In 

such cases, you can simply copy the previous listing to save time.  However, your copied listing 

will initially have an incomplete status.  Note: Your MLS determines what fields will be copied.  Also, you 

can only copy listings that you have permission to edit. 

  

To copy a listing from the Property List screen, 

Step 1:            Select the listing that you want to copy. 

Step 2:            Click the Copy button. 

 

Delete Incomplete 
Follow these steps to delete an incomplete listing (i.e., a listing that has not been assigned an 

MLS number): 

 Step 1:            Go to Add/Edit > View Menu, then search for the incomplete listing.  The results 

will open on the Property List tab.    

Step 2:            Select the incomplete listing. 

Step 3:            Click Delete Incomplete.  

 

Assign Supra Keybox 
This option, which is available on the Property List screen, allows you to assign Supra 

Keybox information to a listing.  To do so, 

Step 1:            Select the listing from the Property List tab.    

Step 2:            Click Assign Supra Keybox, then follow the onscreen instructions. 

  

New Listing 
Follow these steps to add a new listing: 

Step 1:            Click the Add/Edit icon.    

Step 2:            Click the New Listing tab. 

Step 3:            The new listing screen will appear with a short input form.  A minimum amount of 

information is required (i.e., blue fields) to save an incomplete listing.  
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Step 4:            When you have entered all of the information on the short form, you have three 

options: Save and Continue, Save as Incomplete or Cancel. 

 If you choose the Save as Incomplete option, your listing information will be saved and 

the input screen will close.  Saving the listing as incomplete will allow you to enter the 

rest of the information for the listing at your convenience.  Incomplete status listings do 

not have an MLS number assigned to them and they cannot be viewed outside of 

the Add/Edit area. 

 If you choose the Save and Continue option, the entire listing input form will 

appear.  You may use this form to add more information and save the listing as 

incomplete or to finish the form and save it as Active. 

 The Cancel button will exit the screen and cancel all changes made to the listing. 

 Tempo will prompt you if you have not entered required information or if you have 

entered data with an incorrect format.  A listing cannot be given active status until this 

information has been entered. 
  

Note: You can auto-populate various fields on the listing form by clicking an Auto-pop from Tax button. 

 

How do I auto-populate property information from the tax system? 
On the initial Add/Edit short form, select the County and input the Street Number and Name. 

;DoŶ’t use “t., Dƌ., Cƌ., etĐ. afteƌ the Ŷaŵe).  You ĐaŶ also iŶput the Taǆ ID oƌ OǁŶeƌ’s Naŵe aŶd 
click the Get Tax Data button.  Youƌ pƌopeƌtǇ’s taǆ ƌeĐoƌd should displaǇ.  If it is does not, you 

can use a wider search criteria. 

Once your property is located in the tax system, click the List It button.  Tempo will then auto-

populate the property information into the listing input form.  

  

If a tax record does not exist or cannot be found to auto-populate, what should I 

enter in the Tax ID field? 
If Ǉou kŶoǁ the PƌopeƌtǇ’s Taǆ ID, eŶteƌ it iŶto the Tax ID field separated with dashes. (Example: 

123-456-789-0123-456.) You can continue to add your listing without getting a violation notice 

if the information is correct. If the property is a new parcel or has been subdivided recently, you 

can use zeros for the Tax ID.  (Example: 000-000-000-0000-000.) 
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